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Welcome

TekExpress® Ethernet Tx Printable Application Help

Welcome to the TekExpress® Ethernext Tx Conformance Solution. The
application provides turnkey testing & characterization solution for I0GBASE-T
measurements as outlined in IEEE 802.3 Section 55, and for SGBASE-T and
2.5GBASE-T as outlined in NBASE-T Phy Layer Spec 1.1 and IEEE P802.3bz
Section 126. Automation options help the customers to meet their conformance
testing needs and generate detailed reports. User-defined Mode lets customers
make changes to the test limits and perform margin testing as part of extended
product characterization.

_.'g TekExpress Ethernet T) v | e o

DUTID DUTO01 @

= Acquire live waveforms Use pre-recorded waveform files

Data Rate Specification

= 10GBASE-T IEEE 802 3, Section 55

SGBASET \NBASE-T Phy Layer Spec 1.1 | V|
7]

2 5GBASE-T \NBASE-T Phy Layer Spec 1.1 | ¥

Source
» Differential Single Ended

Number of Lanes to Test
e v
Selected Test Lanes @

Lane D

Key features of TekExpress Ethernet Tx include:

= Comprehensive automated solution for NBASE-T, 2.5GBASE-T, SGBASE-
T and 10GBASE-T PHY testing

= One-button selection of multiple tests and four-channel support
m  Detailed test reports with margin and statistical information aid analysis

m  User-defined mode enables flexible parameter control for characterization
and margin analysis

= Single instrument analysis of time- and frequency-domain measurements

= Signal acquisition and analysis support for differential probes or direct SMA
cabling
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Getting help and support

Related documentation

The following documentation is available as part of the TekExpress® Ethernet Tx
Solution application.

Table 1: Product documentation

Item Purpose Location

Help Application operation
and User Interface help

PDF of the help Printable version of the

compiled help = ) F

PDF file that ships with TekExpress Ethernet Tx
Solution software distribution (TekExpress
Ethernet-Tx-Automated-Test-Solution-Software-
Printable-Help-EN-US.pdf).

Seealso  Technical support
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Conventions

Technical support

General Information

Help uses the following conventions:

The term "Application," and "Software" refers to the TekExpress Ethernet Tx
Solution application.

The term “DUT” is an abbreviation for Device Under Test.

The term “select” is a generic term that applies to the two methods of
choosing a screen item (button, control, list item): using a mouse or using the
touch screen.

Table 2: Icon descriptions

Icon Meaning
-l This icon identifies important information.
| |
This icon identifies conditions or practices that could result in loss
of data.
@ This icon identifies additional information that will help you use
the application more efficiently.

Tektronix values your feedback on our products. To help us serve you better,
please send us your suggestions, ideas, or comments on your application or
oscilloscope. Contact Tektronix through mail, telephone, or the Web site,
www.tektronix.com.

When you contact Tektronix Technical Support, please include the following
information (be as specific as possible):

All instrument model numbers

Hardware options, if any

Probes used

Your name, company, mailing address, phone number, FAX number

Please indicate if you would like to be contacted by Tektronix about your
suggestion or comments.

TekExpress® Ethernet Tx Printable Application Help
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Software version number

Application Specific
Information

Description of the problem such that technical support can duplicate the
problem

m  Ifpossible, save the setup files for all the instruments used and the
application.

m  Ifpossible, save the TekExpress setup files, log.xml, *.TekX (session files
and folders), and status messages text file.

m Ifpossible, save the waveform on which you are performing the
measurement as a .wfm file.
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Getting started

Minimum system requirements

The following table shows the minimum system requirements to install and run
the TekExpress Ethernet Tx application.

Table 3: System requirements

Component Description

Oscilloscope Supported Scopes Data Rate
DPQO7254C 2.5GBASE-T and 5GBASE-T
DPQO7354C 2.5GBASE-T, 5GBASE-T, and
DPO/DSA/MSO70000C 10GBASE-T
DPO/MSO70000DX
DPO/DSA70000D
DPO/DPS70000SX

Processor Same as the oscilloscope

Operating System Windows 7

Memory Same as the oscilloscope

Hard Disk Same as the oscilloscope

Display Super VGA resolution or higher video adapter (800 x
600 minimum video resolution for small fonts or 1024 x
768 minimum video resolution for large fonts). The application is
best viewed at 96 dpi display settings

Firmware = TekScope 7.6.5 or above

Software = [ronPython 2.7.3 installed
= PyVisa 1.0.0.25 installed
= Microsoft .NET 4.0 Framework
= Microsoft Internet Explorer 7.0 SP1 or greater, or other Web

browser for viewing reports
= Adobe Reader software 7.0 or greater for viewing portable
document format (PDF) files

Other Devices = Microsoft compatible mouse or compatible pointing device.

= Two USB ports (four USB ports recommended).

1 If TekExpress is running on an instrument that has a video resolution less than 800x600, connect and configure a

second monitor to the instrument.
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Supported Probes

The table gives the list of probes recommended for the TekExpress Ethernet Tx

application.

Oscilloscope Model

For Droop, PSD, Linearity,
Clock Frequency, Jitter-
Master and Jitter Slave
measurements

For Return Loss
measurement

DPO7354 P6330 — Minimum of one and | P6330 — Minimum of two are
maximum of four are required | required
TDP3500 — Minimum of one TDP3500 — Minimum of two are
and maximum of four are required
required
SMA Cables — Minimum of two | NA
are required

DPO70000 and MSO70000 P6330 — Minimum of one and a | P6330 — Minimum of two are

maximum of four are required

required

P7330, P7340A, P7350,
P7360A, P7380A and P7313 -
Minimum of one and maximum
of four are required

P7330, P340A, P7350,
P7360A, P7380A and P7313 -
Minimum of two are required

Trimode probes (P7504, P7506,
P7508, P7513A, P7516 &
P7520A) — A minimum of one
and maximum of four are
required

Trimode probes (P7504, P7506,
P7508, P7513A, P7516 &
P7520A) — Minimum of two are
required

P7350SMA, P7380SMA and NA
P7313SMA - Minimum of one

and maximum of four are

required

SMA cables — Minimum of two | NA

are required

TekExpress® Ethernet Tx Printable Application Help




Getting started

Installing the software

Follow the steps to download and install the latest TekExpress Ethernet Tx
Solution. See Minimum system requirements for compatibility.

1. Type the URL www.tek.com in the address bar of web browser and click
Software Downloads

2. Enter TekExpress Ethernet Tx Solution in the Enter your keywords field,
and click Search

3. Select the latest version of software and follow the instructions to download.
Copy the executable file into the oscilloscope.

4. Double-click the executable and follow the on-screen instructions. The
software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress
Ethernet Tx\

5. Select Analyze > TekExpress Ethernet Tx from the TekScope menu to
launch the application.

View software version

Use the following instructions to view version information for the application and
for the application modules such as the Programmatic Interface and the
Programmatic Interface Client.

To view version information for Ethernet Tx, click &% button in the TekExpress
application and select About TekExpress.

\4 About Tektronix TekExpress Ethernet Tx

’—‘-ﬁu

z‘,'-;'::

TekExpress -
Automated Solutions

NOTE. This example shows a typical Version Details dialog box, and may not
reflect the actual values as shown when you open this item in the application.

TekExpress® Ethernet Tx Printable Application Help 7
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Application directories

TekExpress Ethernet Tx ~ The TekExpress Ethernet Tx application files are installed at the following
application  location:

C:\Program Files\Tektronix\TekExpress\TekExpress Ethernet Tx

. Bin

. Compliance Suites
, Examples

 ICP

| Images

. Lib

. Report Generator

) Tools

The following table lists the application directory names and their purpose.

Table 4: Application directories and usage

Directory names Usage

Bin Contains TekExpress Ethernet Tx application libraries

Compliance Suites Contains compliance-specific files

Examples Contains various support files

ICP Contains instrument and TekExpress Ethernet Tx application-
specific interface libraries

Images Contains images of the TekExpress Ethernet Tx application

Lib Contains utility files specific to the TekExpress Ethernet Tx
application

Report Generator Contains style sheets for report generation

Tools Contains instrument and TekExpress Ethernet Tx application-
specific files

8 TekExpress® Ethernet Tx Printable Application Help



Getting started

Seealso  View test-related files

File name extensions

File name extensions

The TekExpress Ethernet Tx application uses the following file name extensions:

File name extension Description

.TekX Application session files (the extensions may not be displayed)

.py Python sequence file

xml Test-specific configuration information (encrypted) files
Application log files

wfm Test waveform files

.mht Test result reports (default)

Test reports can also be saved in HTML format

pdf Test result reports
Application help document

Xslt Style sheet used to generate reports

Seealso  View test-related files

Application directories

TekExpress® Ethernet Tx Printable Application Help 9
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Operating basics

Launch the application

To launch the TekExpress Ethernet Tx Solution, select Analyze > TekExpress
Ethernet Tx from the TekScope menu.

m TekExpress Ethel n e 0

DUTID DUTOO1 @

= Acguire live waveforms Use pre-recorded waveform files

Data Rate Specification

+ 10GBASE-T IEEE 802.3, Section 55

5GBASE-T ‘NE!ASE—T Phy Layer Spec 1.1 ‘ v |

2 5GBASE-T 'NBASE-T Phy Layer Spec 1.1 | ¥ |

Source
« Differential Single Ended

MNumber of Lanes to Test
ene [v]
Selected Test Lanes @

Lane D

When you launch the application for the first time, the file C:\Users\<username>
\My Documents\My TekExpress\Ethernet Tx\Resources.xml is mapped to drive
X:. This file contains information about available network-connected
instruments. The session files are stored in X:\Ethernet Tx\. If this file is not
found, then the application runs Instrument Discovery Program to detect the
connected instruments before launching Ethernet Tx Solution.

If the application goes behind the oscilloscope application, click Application >
Ethernet Tx to bring it to the front. To keep the Ethernet Tx application window
on top, select Keep On Top from the Ethernet Tx Options menu.

TekExpress® Ethernet Tx Printable Application Help 11
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See also  Application controls

Application panel overview

Application panels overview

TekExpress Ethernet Tx Solution uses panels to group related configuration, test,
and results settings. Click any button to open the associated panel. A panel may
have one or more tabs that list the selections available in that panel. Controls in a
panel can change depending on settings made in that panel or another panel.

DUTID DUTOO! @

{+ Acquire live waveforms | Use pre-recorded waveform files

Specification

IEEE 802 3, Section 55

'NBASE-T Phy Layer Spec 1.1 | ¥ |

\NBASE-T Phy Layer Spec 1.1 | V|

Source

(+ Differential | Single Ended

Mumber of Lanes to Test
e v
Selected Test Lanes a

LaneD

12
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Table 5: Application panels overview

Panel Name Purpose

Setup panel The Setup panel shows the test setup controls. Click the Setup button to
open this panel.
Use this panel to:

= Set DUT tab parameters

= Select tests

= Set acquisition tab parameters

= Set configuration tab parameters

= Set preferences tab parameters

Status panel View the progress and analysis status of the selected tests, and view test
logs.

Results panel View a summary of test results and select result viewing preferences.

Reports panel Browse for reports, save reports as specific file types, specify report

naming conventions, select report content to include (such as summary
information, detailed information, user comments, setup configuration,
application configuration), and select report viewing options.

Seealso  Application controls

Global application controls

Application controls ~ This section describes the application controls.

TekExpress® Ethernet Tx Printable Application Help 13
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Table 6: Application controls description

Start

Item Description

Options menu Menu to display global application controls.

Test Panel buttons Controls that open panels for configuring test settings and options.
Start / Stop button Use the Start button to start the test run of the measurements in the

selected order. If prior acquired measurements are not cleared, then new
measurements are added to the existing set.

The button toggles to the Stop mode while tests are running. Use the
Stop button to abort the test.

Pause / Continue Use the Pause button to temporarily pause the acquisition. When a test is
button paused, this button changes to “Continue.”
Pause
Clear button Use the Clear button to clear all existing measurement results. Adding or
deleting a measurement, or changing a configuration parameter of an
existing measurement, also clears measurements. This is to prevent the
Clear accumulation of measurement statistics or sets of statistics that are not

coherent. This button is available only on Results panel.

TekExpress® Ethernet Tx Printable Application Help
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Item

Description

Application window
move icon

. Tek

Place the cursor over the three-dot pattern in the upper left corner of the
application window. When the cursor changes to a hand, drag the
window to the desired location.

Minimize icon

Click to minimize the application.

Close icon

Click to close the application.

See also. Application panel overview

Options menu overview  To access Options menu, click % in the upper-right corner of the application. It

has the following:

TekExpress® Ethernet Tx Printable Application Help
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Options menu

Default Test Setup
Dpen Test Setup
Save Test Setup
Save Test Setup As

Open Recent

Instrument Control Settings

Keep On Top
Email Settings
Deskew
Help
About TekExpress
Menu Function
Default Test Setup Opens an untitled test setup with defaults selected
Acquire Live Waveforms
Data Rate: 10GBASE-T
Specification: IEEE 802.3, Section 55
Source: Differential
Number of Lanes to Test: 1 Lane
Open Test Setup Opens a saved test setup
Save Test Setup Saves the current test setup
Save Test Setup As | Saves the current test setup with a different file name or file type

Open Recent

Displays the recently opened test setups to open

Instrument Control Detects, lists, and refreshes the connected instruments found on
Settings specified connections (LAN, GPIB, USB, and so on)

Keep On Top Keeps the TekExpress Ethernet Tx application on top in the desktop
Email Settings Use to configure email options for test run and results notifications
Deskew Allows the user to deskew the probes

Help Displays the TekExpress Ethernet Tx help

About TekExpress

= Displays application details such as software name, version number,
and copyright

= Provides a link to the end-user license agreement

= Provides a link to the Tektronix Web site

See also. Application controls
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Operating basics

TekExpress instrument ~ Use TekExpress Instrument Control Settings dialog box to search the instruments
control settings  (resources) connected to the application. You can use the Search Criteria to
search the connected instruments depending on the connection type. The details
of the connected instrument is displayed in the Retrieved Instruments window.

You can access this dialog box from the Options menu.

TekExpress Instrument Control Settings

The connected instruments displayed here can be selected for use under Global
Settings in the test configuration section.

NOTE. Under Instrument Control Settings, select GPIB Option (Default setting),
when using TekExpress Ethernet Tx application.

See also. Options menu overview

View connected  Use TekExpress Instrument Control Settings dialog box to search the instruments
instruments  (resources) connected to the application. The application uses TekVISA to
discover the connected instruments.

NOTE. The correct instruments required for the test setup must be connected and
recognized by the application before running the test.

To refresh the list of connected instruments:
1. From the Options menu, select Instrument Control Settings.

2. In the Search Criteria section of the Instrument Control Settings dialog box,
select the connection types of the instruments to search.

TekExpress® Ethernet Tx Printable Application Help 17
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Instrument search is based on the VISA layer, but different connections
determine the resource type, such as LAN, GPIB, and USB. For example, if
you choose LAN, the search will include all the instruments supported by
TekExpress that are communicating over the LAN.

3. Click Refresh. TekExpress searches for connected instruments.

4. After searching, the dialog box lists the instrument-related details based on
the search criteria. For example, For the Search Criteria as LAN and GPIB,
the application displays all LAN and GPIB instruments connected to the
application.

The details of the instruments are displayed in the Retrieved Instruments table.
The time and date of instrument refresh is displayed in the Last Updated field.

18 TekExpress® Ethernet Tx Printable Application Help



Operating basics

Configure email settings  Use the Email Settings utility to get notified by email when a measurement
completes, or produces any error condition. Follow the steps to configure email
settings:

1. Select Options > Email Settings to open the Email Settings dialog box.

2. (Required) For Recipient email Address(es), enter one or more recipient
email addresses. To include multiple addresses, separate the addresses with
commas.

3. (Required) For Sender’s Address, enter the email address used by the
instrument. This address consists of the instrument name, followed by an
underscore, followed by the instrument serial number, then the @ symbol,
and the email server ID. For example:

DSAS8300 B130099@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server
address of the Mail server configured at the client location, and the SMTP
Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name,
password, and host name in the corresponding fields.

NOTE. If any of the above required fields are left blank, the settings will not
be saved and email notifications will not be sent.

5. Inthe Email Attachments section, select from the following options:
= Reports: Select to receive the test report with the notification email.

= Status Log: Select to receive the test status log with the notification
email. If you select this option, then also select whether you want to
receive the full log or just the last 20 lines.

6. In the Email Configuration section:

= Enter a maximum file size for the email message. Messages with
attachments larger than this limit will not be sent. The default is 5 MB.

= Enter the number in the Number of Attempts to Send field, to limit the
number of attempts that the system makes to send a notification. The
default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use
this check box to quickly enable or disable email notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.
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Email Settings

—Email Settings o

Setup panel

Setup panel overview  The Setup panel contains sequentially ordered tabs that help you guide through
the test setup and execution process.
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DUTID DUTOO! @

{+ Acquire live waveforms | Use pre-recorded waveform files

Specification

IEEE 802 3, Section 55

'NBASE-T Phy Layer Spec 1.1 | ¥ |

\NBASE-T Phy Layer Spec 1.1 | V|

Source
(+ Differential | Single Ended

Mumber of Lanes to Test
e v
Selected Test Lanes i

LaneD

Set DUT parameters  Use the DUT tab to select parameters for the device under test. This settings are

global and apply to all tests for the current session. DUT settings also affect the
list of available tests in the Test Selection tab.
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_.'g TekExpress Ethernet T) v | e o

DUTID DUTOO1 @

= Acquire live waveforms Use pre-recorded waveform files

Data Rate Specification

» | 10GBASE-T IEEE 802 3, Section 55

5GBASE-T [NBASE-T Phy Layer Spec 1.1 | ¥

v]
2 5GBASET \NBASE-T Phy Layer Spec 1.1 | V|

Source
+ Differential Single Ended

Mumber of Lanes to Test
e v
Selected Test Lanes @

Lane D

Click Setup > DUT to access the DUT parameters:

Table 7: DUT tab settings

Setting

Description

DUT ID

Adds an optional text label for the DUT to reports. The default value is
DUTO001. The maximum number of characters is 32.
You cannot use the following characters in an ID name: (.,..,...,\,/:?"<>[")

@ Comments icon
(to the right of the DUT
ID field)

Opens a Comments dialog box in which to enter optional text to add to a
report. Maximum size is 256 characters. To enable or disable comments
appearing on the test report. See Select report options for details.

Acquire live waveforms

Perform analysis on live waveforms.

Use pre-recorded
waveform files

Perform analysis on pre-recorded waveforms.

Data Rate
10GBASE-T Specification

=  |EEE 802.3, Section 55
5GBASE-T Specification

= NBASE-T Phy Layer Spec 1.1
= |EEE P802.3bz, Section 126
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Setting Description
2.5GBASE-T Specification
= NBASE-T Phy Layer Spec 1.1
= |EEE P802.3bz, Section 126
Source
Differential Select the source as Differential
Single Ended Select the source as Single Ended
Number of Lanes to | Select the number of lanes to test.
Test
Setup Click to select the lanes to test.
Selected Test Lanes | Displays the selected lanes.

Figure 1: Test Lane Setup

See also. Select a test

Select tests  Use the Test Selection tab to select the TekExpress Ethernet Tx tests.

TekExpress® Ethernet Tx Printable Application Help

23



Operating basics

Ethernet Tx : 10GBASE-T : IEEE 802.3, Section 55

Gosoeid) (gaqurms)  (Soat)

TRl EREET =+{w] 10GBASE-T Measurements B
~{w| Power Spectrum Density
{~] Linearity
-[w] Tone-1
-[w] Tone-2
Tone-3
Tone-4
--[w] Tone-5
-] Clack Frequency

~{wr] Jitter Master
~[] Jitter Slave
--{~] Return Loss Calibration

--[w] Open Termination

-[v]

—

Test Description

Setthe DUT to operate in Test Mode 6. This
measurement will verify that the transmitter
output level does not droop more than the
maximum specified amount.

Table 8: Test Selection tab settings

Setting Description

Tests Click on a test to select or unselect. Highlight a
test to show details in the Test Description pane.

Test Description Shows a brief description of the highlighted test
in the Test field.

See also. Set acquisition tab parameters

Set acquisition tab ~ Use the Acquisitions tab to view test acquisition parameters. The contents
parameters displayed on this tab depends on the DUT type and the tests selected.
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Ethernet Tx : 10GBASE-T : IEEE 802.3, Section 55

co— T @

Lane A CH1

Return Loss
Source 1 Source 2

TestName i |

ZMa.ximum Output Droop Maximum Qutput Droop-Acg
:Power Spectrum Density Power Spectrum Density-Ac

Tone-1 Tone-1-Acquisition
| |Tone-2 Tone-2-Acquisition
Tone-3 Tone-3-Acquisition
Tone-4 Tone-4-Acquisition
| Tones Tone-5-Acquisition
" Clock Frequency Clock Frequency—Acquisitiuna

T
Acquisition and Save Options
All'Waveforms are saved before analysis

[ Show Acquire Parameters

Signal Validation

Prompt me if Signal... n

Table 9: Acquisitions tab settings

Setting Description

View Probes Click to view the probe configuration
Show Acquire Parameters Select to view the acquisition parameters.
Signal Validation Select the signal validation type

= Prompt me if Signal Validation Fails
= Skip test if Signal Validation Fails

= Use signal as is - Don't Validate

TekExpress® Ethernet Tx Printable Application Help 25



Operating basics

TekExpress Ethernet Tx saves all acquisition waveforms to files by default.
Waveforms are saved in a unique folder for each session (a session starts when
you click the Start button). The folder path is X:\Ethernet Tx\Untitled Session
\<dutid>\<date> <time>. Images created for each analysis, CSV files with result
values, reports, and other information specific to that particular execution are also
saved in this folder.

Saving a session moves the session file contents from the Untitled Session folder
to the specified folder name, and changes the session name to the specified name.

Set configuration tab ~ Use the Configuration tab to view the instruments detected (Global Settings).
parameters
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TekExpress Ethe
v

*  Compliance Mode User Defined Mode

Instruments Detected

— @ Configuration

Real Time Scope MS073304DX ( GPIB8:: 1::INSTR. )

AWG AWGT122C (GPIBO::3::INSTR )

Figure 2: Configuration tab: Global Settings

Table 10: Configuration tab settings

Setting

Description

Compliance Mode

Select to view compliance
mode. By default Compliance
Mode is selected.

User Defined Mode

Select to view user defined
mode

Global Settings

Instruments Detected

Displays the instruments
connected to this application.
Click on the instrument name to
open a list of available
(detected) instruments.

Select Options > Instrument
Control Settings and click
Refresh to update the
instrument list.

NOTE. Verify that the GPIB
search criteria (default setting)
in the Instrument Control
Settings is selected when using
TekExpress Ethernet Tx
application.

Measurements

TekExpress® Ethernet Tx Printable Application Help
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Setting

Description

Maximum Output Droop

Acquire

Population

Analyze

Ref Level
Mid Level
Hysteresis
Start Time
End Time

Power Spectrum Density

Acquire

Acquisition Average

Analyze

Start Frequency

Stop Frequency

Resolution Bandwidth

Power Level Start Frequency
Power Level Stop Frequency
Smoothing Average

Tone-1

Acquire

Acquisition Average

Analyze

Start Frequency
Stop Frequency
Resolution Bandwidth

Tone-2

Acquire

Acquisition Average

Analyze

Start Frequency
Stop Frequency
Resolution Bandwidth

Tone-3

Acquire

Acquisition Average

Analyze

Start Frequency
Stop Frequency
Resolution Bandwidth

Tone-4

Acquire

Acquisition Average

Analyze

Start Frequency
Stop Frequency
Resolution Bandwidth

Tone-5

Acquire

Acquisition Average

Analyze

Start Frequency
Stop Frequency
Resolution Bandwidth

Clock Frequency

Acquire

Population

Analyze

Ref Level
Mid Level
Hysteresis

Jitter Master

Acquire

Acquisition Duration

Analyze

Ref Level
Mid Level
Hysteresis

Jitter Slave

Acquire

Acquisition Duration

Analyze

Ref Level
Mid Level
Hysteresis
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Setting Description
Open Tremination Acquire Acquisition Average
Analyze Smoothing Average
Calibration files path
Short Tremination Acquire Acquisition Average
Analyze Smoothing Average
Calibration files path
Load Tremination Acquire Acquisition Average
Analyze Smoothing Average
Calibration files path
Return Loss Acquire Acquisition Average
Analyze Smoothing Average

Calibration files path

Population. Specifies a limit to the amount of waveform data that is analyzed

Ref Level. Absolute Use to manually set the reference levels.
Percentage Use to set the reference levels as a percentage.

Mid Level. A reference voltage level that defines when the waveform state
transition occurs at a given threshold.

Hysteresis. Used to prevent small amounts of noise in a waveform from
producing multiple threshold crossings. Use when the rising and falling
thresholds for a given reference voltage level are set to the same value.

Start Time. Specifies the Droop measurement start time (Time from the zero
crossing).

End Time. Specifies the Droop measurement end time (Time from the zero
crossing).

Acquisition Average. Specifies the number of waveforms over which averaging is

done.
Start Frequency. Specifies the PSD curve start frequency.

Stop Frequency. Specifies the PSD curve stop frequency.

Resolution Bandwidth. Determines the smallest frequency difference that can be

resolved in the frequency domain output data.
Power Level Start Frequency. Specifies the power level start frequency.

Power Level Stop Frequency. Specifies the power level stop frequency.

TekExpress® Ethernet Tx Printable Application Help
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Set preferences tab
parameters

Smoothing Average. Specifies the window size in terms of number of samples

used for smoothing.

Acquisition Duration. Specifies the waveform acquired time.

Use the Preferences tab to set the application action on completion of a

measurement.

_.'g TekExpress Ethernet T) v ]

MNumber of Runs

|_ Acquire/Analyze each test |1 times

Actions on Test Measurement Failure

[ On TestFailure, stop and notify me of the failure

Popup Settings

|_ Auto close \Warnings and Infermations during Sequencing

Auto close after |10

Seconds

l |_ Auto close Error Messages during Sequencing. Show in Reporis

Aute close after |10

Seconds

Table 11: Preferences tab settings

Setting

‘ Description

Number of Runs

Acquire/Analyze each test <no> times (not
applicable to Custom Tests)

Select to repeat the test run by setting the
number of times. By default, it is selected with
1 run.

Actions on Test Measurement Failure

On Test Failure, stop and notify me of the failure

Select to stop the test run on Test Failure, and
to get notified via email. By default, it is
unselected.

Click Email Settings to configure.

Popup Settings
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Setting Description

Auto close Warnings and Informations during | Select to auto close warnings/informations
Sequencing during sequencing. Set the Auto close time. By
Auto close after <no> Seconds default it is unselected.

Auto close Error Messages during Sequencing. | Select to auto close Error Messages during
Show in Reports Sequencing. Set the Auto close time. By default
Auto close after <no> Seconds it is unselected.

Status panel overview

The Status button accesses the Test Status and Log View tabs, which provide
status on test acquisition and analysis (Test Status tab) and a listing of test tasks
performed (Log View tab). The application opens the Test Status tab when you
start a test run. You can select the Test Status or the Log View tab to view these
items while tests are running.

Test status view

A | TestName Acquisition Acquire Status | Analysis Status
& LaneD

Masimum Output Droop Masimum Output N  F——
Droop-Acquisition

Power

p
Denety heion Tobestarted  Tobestarted

Tone-t Tone-1-Acquistion Tobestared  Tobe staried
Tone-2 Tone-2-Acquistion Tobestared  Tobe staried
Tone-3 Tone-3-Acquistion Tobestared  Tobe staried
Tone-4 Tone-4-Acquistion Tobestared  Tobe staried
Tone-S Tone-£-Acquistion Tobestared  Tobe staried
Clock Frequency Clock Frequency-Acquision  Tobestarted  Tobe started
Jiter Waster Jiter aster-Acquistion Tobestared  Tobe staried
Jiter Slave Jiter Siave-Acquistion Tobestared  Tobe staried
Open Termination OpenTerminaton-Acquistion ~ Tobestarted  To be started
Short Termination ShortTerminaton-Acquistion  Tobestarted  To be started
Load Termination Load Termnafion-Acquistion ~ Tobestarted  Tobe started
Return Loss Return Loss-Acquistion Tobestared  Tobe staried

Initializing un time:enwironment. This might take some time.
03/21/16 08:38:30 : Reading Setup information

03/31/16 08:38:30 * Reading Real Time Scope infomation
03/31/16/08:38:30 * Scope NModel : MSO73304DX

)| |[02/21/16 03:33:30  Scope Seral rumber - B260657

03/31/16/08:38:30 * SPC., FactonyCalbration status on scope : PASSPASS
03/31/16/08:38:30 * Scope fimware version * 76,0 Buid 7
03/31/16/08:3830 * Lineaity Tone-1 selected

03/31/16 08:38.30 - Jiter Moster test selected
03/31/16 08:38.30 - Retum Loss test selected
03/31/16 08:38.31 : Resetting the scope.
03/31/16 08:38:35 : Lane A - Maximum Output Droop ; Data Posiive or Difeeriial source ; CHI
03/31/16 08:38.35 : Execuding Maimum Ouiput Drogp test

q Vet g

03/31/16 08:3839  Perfoming Trigger settings.
03/31/16 08:3839  Performing MATH settings
03/31/16 08:3839 * Acquiing wavefoms.
03/31/16 02:38 41 : Saving MATH1(DI) wavefom
03/31/16 08:38 44 - Analyzing for Droop Postive (%) mi.
03/31/16 08:38:44 * Waveforn retrieved for Maximom Cutout Droop test is : X-\Ethemet Tx\Untiled Session\DUT001\201
03/31/16 08:38:49 * Populating resut for Maximum Output Droop
03/31/16 08:38:50 : Compare mt LE (c=) 10 for Value = 8 185966e+00 Resul:Pass
ivrin i N, Neristve. (%) i

(13721 /16 82850 Anaivr &
4

i »
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Table 12: Status panel Log View controls

Control Description

Message History Lists all executed test operations and timestamp
information.

Auto Scroll Enables automatic scrolling of the log view as
information is added to the log during the test.

Clear Log Clears all messages from the log view.

Save Saves the log file to a text file. Use the standard

Save File window to navigate to and specify the
folder and file name to which to save the log
text.

Seealso  Application panel overview

Results panel

Results panel overview =~ When a test finishes, the application automatically opens the Results panel to
display a summary of test results.

Maximum Cutput  Droop Positive 8.1859681 H:1.8140

Droop

Maximum Cutput  Droop 8.3823625 H:1.6176
* broop Negative & Pass

— Power Spectrum Power Level 3.8000590 L:0.6001
* Density & Pass H:1.3999

Power Spectrum  PSD Curve 0.0000000 H:0.0000

= Density & Pass

— Tone-1 Linearity 60.5782953 L:6.0783
“ Tone-1 9 Pass

— Tone-2 Linearity 61.3811656 L11.0812

& Tone-2 & Pass

_ Tone-3 Linearity 801616282 1147616
“ Tone-3 & Pass

— Tone-4 Linearity

62.5938105 L:20.9933
& Tone-4 & Pass

— Tone-5 Linearity 60.9413947 L22 4414
& Tone-5 & Pass
Clock Frequency  Clock 26184345 L52.6184
] Frequency ) Pass H:47 3816
Deviation
=+ Jitter Master Jitter-Master W Pass 1.0645212 H:4.4355 psec

o \nformative Calibration MLA MLA
Termination completed

(5 Oen Termination  Open

+ Short Termination Calibration MA MLA

€] " Informative
3 omo d
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See also. View a report

Application panels overview

View test-related files  Files related to tests are stored in My TekExpress\Ethernet Tx\ . Each test setup
in this folder has both a test setup file and a test setup folder, both with the test
setup name.

The test setup file is preceded by the TekExpress icon and usually has no visible
file name extension.

Inside the test setup folder is another folder named for the DUT ID used in the
test sessions. The default is DUT001.

Inside the DUTO0O01 folder are the session folders and files. Each session also has
a folder and file pair, both named for the test session using the naming
convention (date) (time). Each session file is stored outside its matching session
folder:

[C)20110520_154553
[C)20110520_154713
[C)20110520_155111
[C)20110520_155920
[C)20110520_160103
v 20110520_154553
Vil 20110520_154713
v 20110520 155111
Vi 20110520_155920
v 20110520_160103

Each session folder contains image files of any plots generated from running the
test session. If you selected to save all waveforms or ran tests using prerecorded
waveform files, these are included here.

The first time you run a new, unsaved session, the session files are stored in the
Untitled Session folder located at ..\My TekExpress\Ethernet Tx\. When you
name and save the session, the files are placed in a folder with the name that you
specify. A copy of the test files stay in the Untitled Session folder until you run a
new test or until you close the Ethernet Tx application.

See also. File name extensions

TekExpress® Ethernet Tx Printable Application Help 33



Operating basics

Reports panel

Reports panel overview  Use the Reports panel to browse for reports, name and save reports, select test
content to include in reports, and select report viewing options.

ID_(t\Elhemet Tx\Reports\DUT001 mht .
Web Archive (*.mht;*. mhtml) v

For information on setting up reports, see Select report options. For information
on viewing reports, see View a report.

See also. Applications panel overview
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Select report options

Click the Reports button and use the Reports panel controls to select which test
result information to include in the report, and the naming conventions to use for
the report. For example, always give the report a unique name or select to have
the same name increment each time you run a particular test.

Select report options before running a test or when creating and saving test
setups. Report settings are included in saved test setups.

In the Reports panel, select from the following report options:

Table 13: Report options

Setting

Description

Report Update Mode

Generate new report

Creates a new report. The report can be in
either .mht or .pdf file formats.

Append with previous run session

Appends the latest test results to the end of the
current test results report.

Replace current test in previous run session

Replaces the previous test results with the latest
test results. Results from newly added tests are
appended to the end of the report.

Report Creation Settings

Report name

Displays the name and location from which to
open a Ethernet Tx report. The default location
is at \My TekExpress\Ethernet Tx\Untitled
Session. The report file in this folder gets
overwritten each time you run a test unless you
specify a unique name or select to auto
increment the report name.

Change the report name or location.

Do one of the following:

= Inthe Report Path field, type over the
current folder path and name.

m  Double-click in the Report Path field and
then make selections from the popup
keyboard and click the Enter button.

Be sure to include the entire folder path, the file
name, and the file extension. For example: C:
Documents and Settings\your user name\My
Documents\My TekExpress\Ethernet Tx
DUTO001.mht.

NOTE. You cannot set the file location using the
Browse button.

Open an existing report.

Click Browse, locate and select the report file
and then click View at the bottom of the panel.

TekExpress® Ethernet Tx Printable Application Help
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Setting

Description

Save as type

Saves a report in the specified file type, selected
from the drop-down list.

NOTE. If you select a file type different from the
default, be sure to change the report file name
extension in the Report Name field to match.

Auto increment report name if duplicate

Sets the application to automatically increment
the name of the report file if the application finds
a file with the same name as the one being
generated. For example: DUT001, DUTO002,
DUTO03. This option is enabled by default.

Create report automatically at the end of the run

Creates report at the end of the run.

Contents To Save

Include pass/fail info in details table

Includes pass/fail info in the details table of the
report.

Include detailed results

Includes detailed results in the report.

Include plot images

Includes plot images in the report.

Include setup configuration

Sets the application to include hardware and
software information in the summary box at the
top of the report. Information includes: the
oscilloscope model and serial number, the
oscilloscope firmware version, and software
versions for applications used in the
measurements.

Include complete application configuration

Includes complete application configuration in
the report.

Include user comments

Select to include any comments about the test
that you or another user added in the DUT tab of
the Setup panel. Comments appear in the
Comments section, under the summary box at
the beginning of each report.

Group Report By

Test Name Select to group the tests in the report by test
name.

Test Result Select to group the tests in the report by test

results

View report after generating

Automatically opens the report in a Web browser,
when the test completes. This option is selected
by default.

View

Click to view the most current report.

Generate Report

Generates a new report based on the current
analysis results.

Save As

Specify a name for the report.
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View a report

Report contents

The application automatically generates a report when test analysis is completed
and displays the report in your default Web browser (unless you cleared the View
Report After Generating check box in the Reports panel before running the
test). If you cleared this check box, or to view a different test report, do the
following:

1. Click the Reports button.
2. Click the Browse button and locate and select the report file to view.
3. In the Reports panel, click View.

For information on changing the file type, file name, and other report options, see
Select report options.

A report shows detailed results and plots, as set in the Reports panel.

TekExpress Ethernet Tx

Tektronix:
T0GBASE-T Test Report

Setup Information
DUT ID DUTO001 Scope MS073304DX, B260657
Date/Time 2016-03-31 08:38:30 SPC, FactoryCali PASS;PASS
Device Type Ethernet Tx Scope F/W Version 7.6.0 Build 7
TekExpress Ethernet Tx Version 1.0.0.143 Channell Probe P7330, B025431
TekExpress Framework Version 4.0.6.266 Return-Loss Probel P7330, B025431
Execution Mode Live Return-Loss Probe2 P7330, B025531
Probing Type Differential
Compliance Made True
Overall Test Result Pass
Overall Execution Time 0:11:51
DUT COMMENT: General comment
Test Name Summary Table
Maximum Output Droop Pass
Power Spectrum Density Pass
Tone-1 Pass
Tone-2 Pass
Tone-3 Pass
Tone-4 Pass
Tone-5 Pass
Clock Frequency Pass
itter Master Pass
Open Termination Pass
Short Termination Pass
Load Termination Pass
Return Loss Pass

Setup configuration information

The summary box at the beginning of the report lists setup configuration
information. This information includes the oscilloscope model and serial number,
optical module model and serial number, and software version numbers of all
associated applications.

To exclude this information from a report, clear the Include Setup
Configuration check box in the Reports panel before running the test.
User comments

If you selected to include comments in the test report, any comments you added
in the DUT tab are shown at the top of the report.
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See also. Results panel overview

View test-related files
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Equipment setup

Click Setup > Test Selection > Schematic to view the equipment setup
diagram(s).

Equipment connection  This section describes the equipment connection setup to perform Differential
setup - Differential Source ~ Source (SMA Probe) Calibration. (For details, see Minimum system

(SMA Probe) requirements).

Equipment connection setup - Differential Source (SMA Probe) applies to all
tests except Jitter-Slave and Return Loss.
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SMA Probe
(Differential Source)

MSO/DPO/DSA?UOOO Series Digital Oscilloscope

ol

on Qi
om0 mojo

_ {Oxoma

Test Fixture
-

_~~ "~ Data-ve

Data +ve

TektroX, Inc AL _A_
i |

DROOP, LINEARITY

JTTERMASTER Psp S 3 | [(S=m
CLOCK FREQ TESTS O) kO] e / ﬂ
R\ £ ‘\ /
SH2 0o B e |_J m SH1
TF-XGbT REV 03 (& © To Differential

SMA Probe
Note: When using high input impedance differential probe, ensure
that each of the single ended lanes is terminated with 50 Q. s
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Equipment connection  This section describes the equipments required and the connection setup to

setup - Single-Ended  perform Single-Ended Source Calibration. (For details, see Minimum system
Source (SMA Cable)  requirements).

Equipment connection setup - Single-Ended Source (SMA Cable) applies to all
tests except Jitter-Slave and Return Loss.

SMA Cable
(Single-Ended Source)
Test Fixture
Bod

MSO/DPO/DSAT70000 Series Digital Oscilloscope

C

’ \‘( oo

Ted p. g]
DROOP, LINEARITY J§2 [

JTTER MASTER, PSD =
CLOCKFREQTESTS ([ )

= o

)
/

To Oscilloscope

(g e

oo

SH2

10

SH1

TF-XGbT_REV 03 |© ©

Note: When using high input impedance differential probe, ensure
that each of the single ended lanes is terminated with 50 Q.

1253000
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Equipment connection  This section describes the equipments required and the connection setup to
setup - Jitter-Slave SMA  perform Jitter-Slave (Differential Source) Calibration. (For details, see Minimum
Probe (Differential Source) ~ system requirements).

Equipment connection setup - Jitter-Slave SMA Probe (Differential Source)
applies to Jitter-Slave measurement.

Jitter-Slave
SMA Probe (Differential Source)

MSO/DPO/DSA70000 Series Digital Oscilloscope

CH1

?G_M—__’:_Jh\ bl tef o) eq |f
T e
Test Fixture PT313.5MA
DUt £
§
— S* Slave } T
et to test wi J 7 " Data-ve
mode 3 %;’\
Data +ve
Jda From Master DUT
. Set to test mode 1
S8 Tektronix, Inc S
G” R2 |_J__R3;-é,
TC2 — 18
sa JTTERSLAVE D )
To DUT [ Jue =

Hl - lusc 2 =~
’ Cut [
B - [ JU2A  waster To differential
: | SMA probe
.| TF-XGbT_REY

D From Master DUT
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Equipment connection  This section describes the equipments required and the connection setup to
setup - Jitter-Slave SMA  perform Jitter-Slave (Single-Ended Source) calibration. (For details, see
Cable (Single-Ended Minimum system requirements).

Source)  Equipment connection setup - Jitter-Slave SMA Probe (Single-Ended Source)
applies to Jitter-Slave measurement.

Jitter-Slave
SMA Cable (Single-Ended Source)

MSO/DPO/DSA70000 Series Digital Oscilloscope

qj"
Test Fixture , ;
DuT [ e B a2
u i 3]
. [1—,' ¥
Slave l] ©
Set to test
mode 3
From Master DUT
Set to test mode 1
S8 Tektronix, Inc St \
Ay ] :\E
—g‘ R2 ] RJE’{',
TC2 o J15
J4  JITTER SLAVE . )
To DUT L_JUG -
p— ] P & 2 Cluisc o I
— i Cut l
— I\ - [Juza _ —wwster——
- )] To Oscilloscope
. SLAVE [—P1 /
" E ‘ ¢ :ﬁ 18 /
=) =
D D+ TF-XGbT_RE¥03 From Master DUT

\/

Note: When using high input impedance differential probe, ensure
that each of the single ended lanes is terminated with 50 €.

126301
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Equipment connection  This section describes the equipments required and the connection setup to
setup - Return Loss  perform Return Loss Calibration. (For details, see Minimum system

Calibration requirements).

Equipment connection setup - Return Loss Calibration applies to Open
Termination, Short Termination and Load Termination measurement.

MSO/DPO/DSA70000 Return Loss Calibration

Series Digital Oscilloscope AWGT7122C
,. | Test Fixture ’

O 00 00 00 00 ©@ QOEm
E s |

Marker 1/ Sync

: 1
Calibration dj—- N

Calibration
Tes:’Fixture
g 1 __Z
Jumper Connections for testing Lane A, B, C & D

Lane A Lane B Lane C Lane D
Oee]| eejO| eeC| |[e@O
oee] J 27 @80 J 27 EBIC J 27 @80 J 2
eslc)| =~ |@Slo) = |oes|  |[@so
@O J:25 I_‘_—_‘_]O J 25 O@ J 25 @O 2
@00 Oee]| CXe OOl
@O J 22 O[E J 22 @O J 22 @O | 22
00O CX e LX (e Oleel
@O J 19 @O J19 @O J 19 OIE | B

Figure 3: Open Termination
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Return Loss Calibration

MSO/DPO/DSAT70000
Series Digital Oscilloscope

Test Fixture
x

For
Calibration

AWGT7122C

Calibration
Test Fixture

OPEN

J28

s

SHORT

Tektronix, Inc

6
J30
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—ReR
;

nggﬁ

5 00 0-0 00 00 © 808

Marker 1/ Sync

X |

Jumper Connections for testing Lane A, B,C & D

Lane A Lane B
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Figure 4: Short Termination
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MSO/DPO/DSAT0000 Return Loss Calibration

Series Digital Oscilloscope AWGT7122C

Test Fixture
.4

5 00 00 00 00 © 808a

Marker 1/ Sync
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Calibration

Calibration
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Figure 5: Load Termination
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Equipment connection  This section describes the equipments required and the connection setup to
setup - Return Loss Setup ~ perform Return Loss Setup. (For details, see Minimum system requirements).

Equipment connection setup - Return Loss Setup applies to Return Loss

measurement

MSO/DPO/DSA70000 Betm LORE S

Series Digital Oscilloscope

Test Fixture

etup

_ AWGT122C

\:‘-——--—-—-—-————-
N\ ./'_"7\

o \@(SH.‘)
R

W
NN

Marker 1/ Sync
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CXie
X
e
CXfe
Clee

l DUT
s \{"r\\\\
oA\
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e —— - LN\
Jumper Connections for testing Lane A, B, C& D
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cee|  |eeo| |@eO|
cwe | |@eo welo|
@0  |@eo|  |ceel|
@8]0 J 25 @80 25 oc@el | 25
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@O J 22 O@ 22 IEO J 22
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@O J19 @O @O J 1
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Prerequisite

48

Compensate the signal
path

Deskew

Use the following procedure to compensate the internal signal acquisition path.
Perform this procedure if the ambient temperature has changed more than 5 °C
(9 °F) since you performed the last signal path compensation. Perform the signal
path compensation once a week. Failure to do so may result in the instrument not
meeting warranted performance levels.

1. Power on and wait for the instrument to complete its warm up period before
continuing with this procedure.

Disconnect any probes you have connected to the input channels.
Set the instrument to Menu mode.
Select Instrument Calibration from the Utilities menu.

Note any instructions that appear in the resulting control window.

AR

Click Run SPC to begin the procedure. The procedure may take several
minutes to complete.

7. Verify that the Status changes to Compensated after the procedure is
complete. If the Calibration Status field indicates anything other than
Compensated, see Signal Path Compensation Status for information on the
readout and recommended action.

NOTE. When making measurements at vertical scale settings less than or equal to
5 mV, you should perform the signal path compensation at least once a week.
Failure to do so may result in the instrument not meeting warranted performance
levels at those volts/div settings.

If skew is present between positive and negative channels, then the channels need
to be deskewed before being used for waveform measurements. TekExpress
Ethernet Tx provides support for channel deskew using the following method:

1. Determine what the skew is for each channel.
2. From the TekScope menu, select Vertical > Deskew.

3. In the Deskew/Attenuation window, click the channel (1 — 4) button for the
first channel to be deskewed.

4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew
can be +ve or —ve.

5. Click the channel button for the next channel and repeat step 4.

6. After entering the skew for all the channels that require it, from the Options
menu in TekExpress Ethernet Tx, select Deskew.
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7. In the Deskew dialog box, select the desired level:

= Less than 100 mV signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is less than 100 mV/division.

= 100 mV or greater signal amplitude: Select this if the signal amplitude is
such that the oscilloscope’s vertical setting is greater than 100 mV/
division.

Figure 6: Deskew
8. Click Read Deskew/Attn.

9. When the status in the dialog box indicates the deskew is finished, click
Close.

Each input channel has its own deskew settings. Deskew compensates individual
channels for probes or cables of different lengths. The instrument applies the
delay values after each completed acquisition. The deskew values are saved as
part of the instrument setup. The deskew values for the selected channel are
retained until you change the probe, you restore a saved setup, or you recall the
factory setup.
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Running tests

50

Prerun checklist

Select tests, set acquisition parameters, set configuration parameters, set
preferences parameters, and click Start to run the tests. While tests are running,
you cannot access the Setup or Reports panels. To monitor the test progress,
switch between the Status panel and the Results panel.

While the tests are running, other applications may display windows in the
background. The TekScope application takes precedence over other applications,
but you can switch to other applications by using Alt + Tab key combination. To
keep the TekExpress Ethernet Tx application on top, select Keep On Top from
the TekExpress Options menu.

The application displays report when the tests execution is complete.

1. Make sure that the instruments are warmed up (approximately 20 minutes)
and stabilized.

2. Perform compensation: In the oscilloscope main menu, select Utilities >
Instrument Compensation. Click Help in the compensation window for
steps to perform instrument compensation.
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Test setup files overview

Saved test setup information (such as the selected oscilloscope, general
parameters, acquisition parameters, measurement limits, waveforms (if
applicable), and other configuration settings) is saved under the setup name at X:
\Ethernet Tx.

Use test setups to:

= Run a new session, acquiring live waveforms, using a saved test
configuration.

= Create a new test setup based on an existing one.

= View all the information associated with a saved test, including the log file,
the history of the test status as it executed, and the results summary.

= Run a saved test using saved waveforms.

Seealso  Save a test setup
Open (load) a saved test setup

Save a test setup

You can save a test setup before or after running a test. You can create a test
setup from already opened test setup, or using default test setup. When you select
the default test setup, the parameters are set to the application’s default value.

Select Options > Save Test Setup to save the opened setup.

Select Options > Save Test Setup As to save the setup with different name.
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Open (load) a saved test setup

To Open (load) a saved test setup, do the following:

1.
2.

Select Options > Open Test Setup.

Select the setup from the list and click Open. Setup files are located at X:
\Ethernet Tx\.

See also Create a test setup using an existing one

Create a test setup from default settings

Create a test setup from default settings

To create a test setup using default settings, follow the steps:

1.

Select Options > Default Test Setup. For default test setup, the parameters
are set to the application’s default value.

Click application Setup and set the parameters
Click application Reports and set the report options

Optional: Click Start to run the test and verify that it runs correctly and
captures the specified test information and reports. If it does not, then edit the
parameters and repeat this step until the test runs to your satisfaction

Select Options > Save Test Setup. Enter the file name and click Save. The
application saves the file to X:\Ethernet Tx\<session_name>

Create a test setup using an existing one

To create a test setup using an existing one, follow the steps:

1
2
3
4.
5
6

52

Select Options > Open Test Setup

Select a setup from the list and then click Open

Click application Setup and modify the parameters
Click application Reports and modify the report options
Select Options > Save Test Setup As

Enter test setup name, and click Save

TekExpress® Ethernet Tx Printable Application Help



TekExpress Ethernet Tx measurements

Maximum output droop

This section verifies that the transmitter output level does not drop more than the
maximum specified amount.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

= DUT shall be configured to transmit test mode 6 waveform

m  If acquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential, then provide differential data waveform as input to
the measurement.

= REFLEVEL, MIDLEVEL and HYSTERESIS for edge finding
= START TIME and STOP TIME

= POPULATION

= Number of ACQUISITION AVERAGES
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Measurement procedure

1.

If acquisition is single ended, then compute differential waveform (scope
math) using acquired single ended signals.

Compute edges of differential signal using midlevel and hysteresis dialed by
the user in the user interface.

If Droop type is “POSITIVE” then

a. Consider rising edges for further computation. Waveform Edges = rising
edges

Else

a. Consider falling edges for further computation. Waveform Edges =
falling edges

For every edge in Waveform Edges,

a. Compute average value of NAVERAGE points around the edge Position
+ start time. This gives High Voltage.

b. Compute average value of NAVERAGE points around the edge Position
+ stop time. This gives Low Voltage.

c¢. Compute Droop in % = ((High Voltage — Low Voltage)/High Voltage) *
100.

d. Store High Voltage, Low Voltage, Edge Position and Droop in %.

Compute Maximum, Minimum, Mean and number of Droops from the
collected result in step 4.

Maximum droop in % will be used for comparing with limits given in
specification.

Transmitter timing Jitter-Master

54

This section verifies that the transmitter timing jitter - master of the PMA is
within the conformance limits.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

= DUT shall be configured to transmit test mode 2 waveform

m  [facquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential then provide differential data waveform as input to
measurement.

= REFLEVEL, MIDLEVEL and HYSTERESIS for edge finding
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®  Acquisition duration

= Apply Band Pass Filter — Yes or No
Measurement procedure

1. If Acquisition is SINGLE ENDED then

a. If APPLY FILTER is YES then, APPLY the band pass filter with Fc as
(200 MHz/S) with band width as 20 KHz on single ended signals.

b. Compute Differential signal (scope math) using acquired single ended
signals

Else

a. If APPLY FILTER is YES then, APPLY the band pass filter with Fc as
(200 MHz/S) with band width as 20 KHz on differential signal.

b. Acquire Differential signal

2. Compute edges of differential signal using midlevel and hysteresis dialed by
the user in the user interface.

3. Determine the direction of first edge

a. If first edge direction is rise, then consider only the rising edges for
further computation. Waveform Edges = rising edges

b. If first edge direction is rise, then consider only the falling edges for
further computation. Waveform Edges = falling edges

4. Do a least square fit using Waveform Edges. X being edge number and Y
being edge position.

Compute slope and intercept. Intercept gives starting edge position. Slope
gives ideal duration between Waveform Edges.

Using Slope and Intercept, reconstruct the ideal position of Waveform Edges.
5. For every Waveform Edge, Compute TIE.

TIE = Actual position of Waveform Edges — Ideal position of Waveform
Edges

6. Compute RMS of TIE.

7. RMS of TIE will be used for comparing with limits given in specification
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Transmitter timing Jitter-Slave

56

This section verifies that the transmitter-slave of the PMA is within the
conformance limits.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

= DUT shall be configured to transmit test mode 6 waveform

m  If acquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential then provide differential data waveform as input to
measurement.

= REFLEVEL, MIDLEVEL and HYSTERESIS for edge finding

®m  Acquisition duration

= Apply Band Pass Filter — Yes or No
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Measurement procedure
1. If Acquisition is SINGLE ENDED then,

a. If APPLY FILTER is YES, then APPLY the band pass filter with Fc as
(200 MHz/S) with band width as 20 KHz on single ended signals.

b. Compute Differential signal(scope math) using acquired single ended
signals

Else

a. If APPLY FILTER is YES then, APPLY the band pass filter with Fc as
(200 MHz/S) with band width as 20 KHz on differential signal.

b. Acquire Differential signal

2. Compute edges of differential signal using midlevel and hysteresis dialed by
the user in the user interface.

3. Determine the direction of first edge.

a. If first edge direction is rise, then consider only rising edges for further
computation. Waveform Edges = rising edges

b. If first edge direction is fall, then consider only falling edges for further
computation. Waveform Edges = falling edges

4. Do a least square fit using Waveform Edges. X being edge number and Y
being edge position.

Compute slope and intercept. Intercept gives starting edge position. Slope
gives ideal duration between Waveform Edges.

Using Slope and Intercept, reconstruct the ideal position of Waveform Edges.
5. For every Waveform Edge, Compute TIE.

TIE = Actual position of Waveform Edges — Ideal position of Waveform
Edges.

6. Compute RMS of TIE.

7. RMS of TIE will be used for comparing with limits given in specification
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Transmitter Power Spectral Density and Power level

58

This section verifies that the transmitter Power Spectral Density (PSD) and
transmit power level are within the conformance limits.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

DUT shall be configured to transmit test mode 6 waveform

If acquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential then provide differential data waveform as input to
measurement.

START FREQUENCY, RESOLUTION BANDWIDTH, STOP
FREQUENCY for configuring SPECTRAL MAGNITUDE MATH function

ACQUISITION AVERAGES

SMOOTHING AVERAGES - the window size used for smoothing the PSD
curve
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Measurement procedure

1. If acquisition is single ended, then compute differential waveform (scope
math) using acquired single ended signals.

2. Compute the mean of the differential signal, the DC component.
3. Remove the DC component from the differential signal.
MATH2 = Differential signal — Mean (Differential Signal).
Mean is computed using scope measurement.
4. Compute the average of spectral magnitude of MATH2
MATH3 = AVG (SpectralMag (MATH?2))
SpectralMag settings are as follows:
m  Center Frequency: STOP FREQUENCY/2
= Frequency Span: STOP FREQUENCY
= Window Type: GAUSSIAN
m  Vertical Axis Scale: Linear
m  MATH3 averages: ACQUISITION AVERAGES
®m  Resolution Bandwidth: RESOLUTION BANDWIDTH
= Gate position =0
m  Gate Duration = (2/Resolution Bandwidth in Hz)
Factor of 2 is because of Gaussian window

5. Do a moving average of spectral signal with number of averages equal to
SMOOTHING AVERAGES dialed by user in user interface.

6. Compute linear power spectrum of moving averaged signal. Determine the
area under the linear power spectrum.

7. Compute the offset/correction value.

Offset/correction value = function (Resolution Bandwidth configured by
user, termination resistance of 100 Ohm, dB to dBm conversion factor,
constant factor of 1.05)

Offset/correction value = 10*log10 (dB to dBm conversion factor) —
10*1og10 (Resolution Bandwidth) — 10*log10 (termination resistance) +
constant factor

Offset/correction value = 10*log10 (1000) — 10*log10 (Resolution
Bandwidth) — 10*log10 (100) + 1.05

Offset/correction value = 11.05 — 10*1og10 (Resolution Bandwidth)

8. Power in dBm = 10*log10(Area under the linear power spectrum) + Offset
value

9. Convert power spectrum in linear scale to dB scale.

10. Compute power spectrum in dBm/Hz
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Power Spectrum in dBm/Hz = power spectrum in dB + Offset value
11. Power in dBm is compared with limits given in specification

12. PSD curve is compared with limit curve given in specification

Voltage Spectrum of Acquisition averaged Moving averaged Linear Power
differential Siqn‘g Voltace quctrum Voltage Soec\;rum sgecm:‘m P
\ \ | [ ]
\ [
| | . | )
Differential Spectral Acquisition Moving \ Linear —
Signal Magnitude_ Averaging Averaging Power /
Computation Spectrum

Area under
power spectrum

iscalag)
Power in dBm Computation | Area under

*—— of Powerin the curve

dBm < computation
S
PSD in dBm/Hz Computation Computation of
«———— ofPSDin | —| Power

Spectrum in dB

dBm/Hz \
~—
| Spectrum in dB

[ Offset Computation

Transmitter clock frequency

This section verifies that the frequency of the transmit clock is within the
conformance limits.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

= DUT shall be configured to transmit test mode 6 waveform

m  If acquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential then provide differential data waveform as input to
measurement.

= REFLEVEL, MIDLEVEL and HYSTERESIS for edge finding.
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Measurement procedure

1.

If acquisition is single ended, then compute differential waveform (scope
math) using acquired single ended signals.

Compute edges of differential signal using midlevel and hysteresis dialed by
the user in the user interface.

Compute edge to edge duration
Determine the mean, maximum and minimum edge to edge duration

Determine the mean deviation, maximum deviation and minimum deviation
in terms of ppm from the nominal frequency (edge to edge frequency of test
mode 2 signal).

Mean deviation in terms of ppm = ((1/mean edge to edge duration) —
Expected edge to edge period)*1e6/Expected edge to edge period

Maximum deviation in terms of ppm = ((1/minimum edge to edge duration) —
Expected edge to edge period)*1e6/ Expected edge to edge period

Minimum deviation in terms of ppm = ((1/maximum edge to edge duration) —
Expected edge to edge period)*1e6/ Expected edge to edge period

Mean deviation in ppm is compared with limits.

Transmitter non-linear distortion

This section verifies that the output of the transmitter conforms to the transmitter
linearity requirements.

Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Inputs

DUT shall be configured to transmit test mode 6 waveform

If acquisition is single ended, then provide Data+ and Data- waveforms. If
acquisition is differential then provide differential data waveform as input to
measurement.

START FREQUENCY, RESOLUTION BANDWIDTH, STOP
FREQUENCY for configuring SPECTRAL MAGNITUDE MATH function

ACQUISITION AVERAGES
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Measurement procedure

1.

62

If acquisition is single ended, then compute differential waveform (scope
math) using acquired single ended signals.

Compute the average of spectral magnitude of differential signal

MATH3 = AVG (SpectralMag (Differential Signal))

SpectralMag settings are as follows:

m  Center Frequency: STOP FREQUENCY/2

= Frequency Span: STOP FREQUENCY

= Window Type: GAUSSIAN

®m  Vertical Axis Scale: dB

®  MATH3 averages: ACQUISITION AVERAGES

®=  Resolution Bandwidth: RESOLUTION BANDWIDTH

= Gate position =0

m  Gate Duration = (2/Resolution Bandwidth in Hz)
Factor of 2 is because of Gaussian window

Determine the peaks (two) and their corresponding frequencies in the
spectrum.

Check whether peaks correspond to the tone pair (based on the sub-test
selected). If not then exit the test.

Intermodulation frequencies for above found peak frequencies and their
corresponding amplitudes up to 20th order are found using the spectrum

Determine the intermodulation distortion.

Intermodulation distortion = Sum (Amplitudes of IMF for above found peak
frequencies up to 5th order) / Sum (Amplitudes of peak frequencies)

Intermodulation distortion in % = Intermodulation distortion * 100

Spurious Frequency Dynamic Range (SFDR) = Minimum (Amplitudes of
peak frequencies) — Maximum (Amplitudes of IMF).

SFDR is compared with limits given in specification.
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MDI return loss

This section verifies that the return loss of the DUT is within conformable limits.
Required test equipment

Minimum system requirements

Supported Probes

Equipment connection diagram

Return loss is a measure of the signal power that is reflected due to the
impedance mismatch.

Return loss = 20*log10 (Reflected / Incident)

Return loss describes the degree of mismatch between a load and characteristic
impedance of a transmission system.

Return loss measurement setup involves fixture, AWG, AWG signal, probes,
DUT and oscilloscope. Return loss measurement can be divided into 3 steps

m  Return Loss calibration
= Computation of error coefficients
= Computation of return loss
1. Return Loss Calibration
Inputs
®m  Wide band calibration signal transmitted from AWG.
= Let RJ45 patch chord be connected to open impedance.

m  Waveform acquired using a probe connected to input of reference
impedance — waveform1

m  Waveform acquired using a probe connected to input of DUT cable under
test — waveform?2

= ACQUISITION AVERAGES — Used for averaging acquired time
domain signal

m SMOOTHING AVERAGES — Used internally by C# module for
smoothing the return loss curve
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Calibration procedure

a. Incident Signal = Waveform2 + (Waveform1 — Waveform?2) =
Waveforml

b. Reflected Signal = Waveform2 — (Waveforml — Waveform?2) =
2*Waveform2 — Waveform1

c¢. Compute FFT of incident signal and FFT reflected signal
Real Part of FFT of Incident Signal = (SpectralReal (Waveform1))
Imaginary Part of FFT of Incident Signal = (Spectrallmag (Waveform1))

Real Part of FFT of Reflected Signal = (SpectralReal (2*Waveform2 —
Waveform1))

Imaginary Part of FFT of Reflected Signal = (Spectrallmag
(2*Waveform2 — Waveform1))

d. Compute Gamma (return loss without error correction) as complex
division of reflected signal by incident signal

Gamma = Complex (Real Part of FFT of Reflected Signal, Imaginary
Part of FFT of Reflected Signal) / Complex (Real Part of FFT of Incident
Signal, Imaginary Part of FFT of Incident Signal)

e. Repeatsteps l.ato 1.d with waveforml and waveform2 captured using
short and load impedance (100 Ohm).

2. Computation of Error Coefficients
Inputs

a. Gamma (Complex) values computed with different loads — open, short
and load ('m1, I'm2, I'm3)

Procedure/Steps:

a. Compute error coefficients a, b and ¢ using 'm1, 'm2 and I'm3 values

I'ml— I'm?2
a=Tm2—Tm3+ — .I'm2
I'm2 + I'ml

b=Im3

I'ml — I'm2
T Tmz+ rm1

3. Computation of Return Loss
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Inputs
Wide band calibration signal transmitted from AWG.
b. Let RJ45 patch chord be connected to DUT.

c¢. Waveform acquired using a probe connected to input of reference
impedance — waveform1

d. Waveform acquired using a probe connected to input of DUT cable under
test — waveform?2

e. Error coefficients a, b and ¢

f. ACQUISITION AVERAGES — Used for averaging acquired time
domain signal

g. SMOOTHING AVERAGES — Used internally by C# module for
smoothing the return loss curve
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Procedure/Steps:

a.

f.

g.

66

Incident Signal = Waveform2 + (Waveform1 — Waveform?2) =
Waveforml

Reflected Signal = Waveform2 — (Waveforml — Waveform2) =
2*Waveform2 — Waveform1

Compute FFT of incident signal and FFT reflected signal
Real Part of FFT of Incident Signal = (SpectralReal (Waveform1))
Imaginary Part of FFT of Incident Signal = (Spectrallmag (Waveform1))

Real Part of FFT of Reflected Signal = (SpectralReal (2*Waveform2 —
Waveforml))

Imaginary Part of FFT of Reflected Signal = (Spectrallmag
(2*Waveform2 — Waveform1))

Compute Gamma (return loss/reflection coefficient without error
correction) as complex division of reflected signal by incident signal
(I'm)

Gamma = Complex (Real Part of FFT of Reflected Signal, Imaginary
Part of FFT of Reflected Signal) / Complex (Real Part of FFT of Incident
Signal, Imaginary Part of FFT of Incident Signal)

Compute error corrected reflection coefficient

'm—0»b
[A = ——
a—clm

Compute return loss in dB scale as Return Loss = 20*log10 (Absolute
(T'A))

Re-normalize the return loss to 85 Ohm and 115 Ohm.

G tZ10hm = p+ 14
amma a m_l+ﬁ'.FA
where = f§ = Za-n
ZA+Z1
ZA — 100 Ohm

Z1 — 85 Ohm or 115 Ohm

I'A — Reflection coefficient with 100 Ohm impedance
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Return Loss at Z1 Ohm = 20*log10 (Absolute (Gamma at Z1 Ohm))

h. Return Loss curve is compared with limits given in specification.
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About SCPl command

You can use Standard Commands for Programmable Instruments (SCPI) to

communicate with the TekExpress application.

Socket configuration for SCPI commands

This section describes the steps for TCPIP socket configuration and TekVISA

configuration to execute the SCPI commands.

TCPIP socket 1.
configuration

Click Start > Control Panel > System and Security > Windows Firewall >
Advanced settings

e

:Eg

—
@uvlﬂ » Control Panel » System and Security » Windows Firewall - | &,l

Search Con... O |

Control Panel Home

Allow a program or feature
through Windows Firewall

) Change notification settings

%) Turn Windows Firewall on or
off

| Restore defaults
[ ) Advanced settings

Troubleshoot my network

See also
MAction Center

Network and Sharing Center

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer
through the Internet or a network.,

How does a firewall help protect my computer?

What are network locations?

@ For your security, some settings are managed by your system administrator.

. [@ Domain networks

Metworks at a workplace that are attached to a domain

Connected (4)

Windows Firewall state: On

Incoming connections: Block all connections to programs that are not on the

list of allowed programs

Active domain networks: ij tektroniz.net

Metification state: Do net notify me when Windows Firewall blocks a

new program

. '@ Home or work (private) networks Not Connected V

. '@) Public networks

Not Connected (¥

@
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2.

3.

In Windows Firewall with Advanced Security menu, select Windows
Firewall with Advanced Security on Local Computer > Inbound Rules

and click New Rule...

[

i,

e = N
@ Windows Firewall with Advanced Security =S
File Action View Help
e sEE
i Windows Firewall with Advance Actions
Inbound Rul
A3 Inbound Rules Mame Group Profile  Ensbled  Action “ || Inbound Rules -
Outbound Rules “F
B Connection Security Rules o|ff €@ New Rue...
& %L Monitoring T Filter by Profile 3
W Fiter by State »
Y Fiter by Group »
view »
[d] Refresh
|5 Exportlist...
H reb

Tektronix VISA Call Monitor &
# Disable Rule

& cut

52 Copy

K Delete

[E] Properties

H Hep

In New Inbound Rule Wizard menu
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a. Select Port and click Next

-
0 MNew Inbound Rule Wizard ﬁ

Rule Type

Select the type of firewal rule to create.

Steps:
& Rule Type What type of rule would you like to create?
@ Protocol and Ports
@ Action ©) Program
@ Profile Fule that controls connections for a program.
@ Name @ Port

Rule that controls connections fora TCP or UDP port.

) Predefined:
BranchCache - Content Retrieval (Uses HTTF)
Rule that controls connections for a Windows experience.
() Custom
Custom rule.

Leam more about nule types

<Back  |[_ MNed> |[ Cancel
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b. Select TCP as rule apply and enter 5000 for Specific local ports and

click Next

-
0 MNew Inbound Rule Wizard

Protocol and Ports

Specify the protocols and ports to which this rule applies.

Steps:

@ Rule Type Does this rule apply to TCF or UDP?
@ Protocol and Ports @ 1ICP

@ Action © UppP

@ Profile

@ Name

Does this rule apply to all local ports or specific local ports?

) All local ports

@ Specific local ports: 5000|
Example: 80, 443, 5000-5010

Leam more about protocol and ports

<Back [ Nee> |

Cancel
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c¢. Select Allow the connection and click Next

-
0 MNew Inbound Rule Wizard

Action

Steps:
@ Rule Type

@ Protocol and Ports
@ Action

@ Profile

]

Name

Specify the action to be taken when a connection matches the conditions specified in the rule

What action should be taken when a connection matches the specified conditions?

@ Allow the connection

This includes connections that are protected with |Psec as well as those are not.

) Allow the connection if it is secure

This includes only connections that have been authenticated by using IPsec. Connections
will be secured using the settings in |Psec properties and rules in the Connection Security
Rule node.

Leam more about actions
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d. Select Domain, Private, Public and click Next

-
0 MNew Inbound Rule Wizard ﬁ

Profile

Specify the profiles for which this nule applies.

Steps:
@ Rule Type When does this rule apply?
@ Protocol and Ports
@ Action Domain
» Profile Applies when a computer is connected to its corporate domain.
@ MName Private
Applies when a computer is connected to a private network location.
Public

Applies when a computer is connected to a public network location.

Leam more about profies

<Back || Net> ][ Cancel
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e. Enter Name, Description (optional), and click Finish

-
o MNew Inbound Rule Wizard

Name

Specify the name and description of this rule

Steps:
Rule Type
Protocal and Ports

Profile Mo

[
[
@ Action
[

Tek Express
[

Name

Description (optional):

<Back || Fnsh | [ Cancel

4. Check whether the Rule name is displayed in Windows Firewall with
Advanced Security menu > Inbound Rules

r
@ Windows Firewall with Advanced Security [E=REEE

File Acton View Hep

@ = BE

P Windows Firewall with Advancd Loy Actions

&3 Inbound Rules

Outbound Rules plome Group Profile  Ensbled  Action .l.l\lxmnd Rules
B Connection Security Rules || SPUEEEIED All Yes Allow @3 newRule...
» B Monitoring W Filter by Profile

W Filter by State

Y Fiter by Group
View

[ Refresh

|5 Exportlist...

H reo

TekExpress

% Disable Rule

& cut

52 Copy

K Delete

[E] Properties

EH Hep

[

vy v v -
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TekVISA configuration

1.

Click Start > All Programs > TekVISA > OpenChoice Instrument

Manager

CpenChoice Instrument Manager

Fle Edit Help

Instruments

GPIB8::1::INSTR

< | m

Last Updated: 12/17/2015 10:34 PM

Instrument List Instrument
Update Identify...

w | O

Search Criteria.. Properties.

Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste. ..

Start Application or Utility

Tekironix
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2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on.
Select Socket from the drop-down list, enter the IP address of the

TekExpress device in Hostname and type Port as 5000. Click to
configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application
are in the same system, else enter the IP address of the TekExpress
application system.

-
Search Criteria | =

v Search LAM

[~ Auto Discovery

Hostname Port
|Socket ~| | |[s000 |

[Socket| 127.0.0.1 5000
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3. Click Search to setup the TCPIP connection with the host. Check whether
the TCPIP host name is displayed in OpenChoice Instrument Manager >
Instruments

OpenChoice Instrument Manager [=[E[T=n]

Fle Edit Help

Instruments Applications and Utilities

OpenChoice Call Monitor
OpenChoice Talker Liste

¥ Search LAN

I~ Auto Discovery

Hostname Port

(s I—

[Eackef] 127.0.0.1 5000

<[ i
Last Updated: 12/17/2015 10:35 PM
Instrument List
Update
“ Start Application or Utility
-~

Search Criteria.-

Tekironix

4. Double-click OpenChoice Takler Listener and enter the Command *IDN?
in command entry field and click Query. Check that the Operation is
successful and Talker Listener Readout displays the Command / Data.

-
3 OpenChoice Talker Listener = ne

fle Edit Toos Help

Enter Command or Script
"IDN?

Wite  Read  Query  Hex Eniry Enabled
( . . |

Command / Seript History

Last Updated 12/17/2015 10:36 PM JAutoQuery - False ; Term Char - LF

Update Reset Communications Run Single Step Loop
S A 4

Talker Listener Readout: Display As: @ ASCIOnly @ Hex and ASCI

Command / Data
12/17/2015 10:... 0.0170s VISA TCPIP::127.0.0.1::5000::50CKET Qpen Session
1217/2015 1 0.0008s MS054 . *IDN? Write

121772015 1 0.0775s TCPIP:... TekExpress Read

@ Operation Successful
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TEKEXP:*IDN?

Syntax

Inputs

Outputs

Example

TEKEXP:*OPC?

Syntax

Inputs

Outputs

This command queries the active TekExpress application name running on the
scope.

TEKEXP:*IDN?\n

NA

Returns active TekExpress application name running on the scope

If TEKEXP:*IDN?\n Returns "TekExpApp", then TekExpApp is the name of the

active TekExpress application running on the scope.

This command queries the execution status of the last executed command.

TEKEXP:*OPC?\n

NA

0 - last command execution is not complete

1 - last command execution is complete
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Example  If TEKEXP:*OPC?\n returns 0, then the last command execution is not complete.

TEKEXP:ACQUIRE_MODE

This command sets the acquire mode as live or pre-recorded.

Syntax ~ TEKEXP:ACQUIRE_MODE {LIVE | PRE-RECORDED}\n

Inputs  {LIVE | PRE-RECORDED}

Outputs NA

Example  TEKEXP:ACQUIRE MODE PRE-RECORDED\n sets the acquire mode as pre-
recorded.

TEKEXP:ACQUIRE_MODE?

This command queries the acquire mode type.

Syntax ~ TEKEXP:ACQUIRE MODE?\n

Inputs NA

Outputs  {LIVE | PRE-RECORDED}
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Example

TEKEXP:EXPORT

Inputs

Example

TEKEXP:INFO?

If TEKEXP:ACQUIRE MODE?\n returns "LIVE", then acquire mode is set to

live.

This command returns all the bytes of data to the specified file.

Syntax

Outputs

TEKEXP:EXPORT REPORT\n

Returns the report file in bytes

TEKEXP:EXPORT WFM,"<FileName>"\n

Returns the specified waveform file in bytes

TEKEXP:EXPORT IMAGE,"<FileName>"\n

Returns the specified image file in bytes

FileName - Specifies the file name

TEKEXP:EXPORT REPORT\n returns the report file in bytes. This can be
written into another file for further analysis.

NOTE. This command can be executed through scripts only as this command
requires FileName parameter to be parsed from TEKEXP:INFO? command.

This command queries the information about the file(s).

Syntax

Outputs

TEKEXP:INFO? REPORT\n

<ReportFileSize>,"<ReportFileName.mht>"

TEKEXP:INFO? WFMi\n

<WfmFile1Size>,"<WfmFileName1.wfm>":<Wfm
File2Size>,"<WfmFileName2.wfm>";...

TEKEXP:INFO? IMAGE\n

<Image1FileSize>,"<Image1FileName>";<Image
2FileSize>,"<Image2FileName>" ;...
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Example

TEKEXP:INSTRUMENT

Syntax

Inputs

Outputs

Example

82

If TEKEXP:INFO? REPORT\n returns “100”,”ReportFileName.mht”, then
100 bytes is the filesize and ReportFileName is the filename.

If TEKEXP:INFO? WFM\n returns “100”,“WfmFileNamel.wfm”;*“200”,

“WimFileName2.wfm”.

This command sets the value for the selected instrument type.

TEKEXP:INSTRUMENT "<InstrumentType>",<Value>"\n

InstrumentType

Value

TIP. Check Command parameters list for InstrumentType and Value parameters.

NA

TEKEXP:INSTRUMENT "<Real Time Scope>",<111>"\n sets the instrument
value as 111 for the selected instrument type XXX.
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TEKEXP:INSTRUMENT?

Syntax

Inputs

Outputs

Example

This command queries the instrument selected for the specified instrument type.

TEKEXP:INSTRUMENT? "<InstrumentType>"\n

InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

Returns the instrument selected for the specified instrument type

If TEKEXP:INSTRUMENT? “Real Time Scope”\n returns "InstrumentA", then
InstrumentA is the selected instrument for the instrument type Real Time Scope.

TEKEXP:LASTERROR?

Syntax

Inputs

This command queries the last error string occurred for the current TCP session.
If there are no errors since startup, or since the last call to
TEKEXP:LASTERROR?\n, this command returns an empty string.

TEKEXP:LASTERROR?\n

NA
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Outputs  <string>

Example  If TEKEXP:LASTERROR?\n returns "ERROR: ErrorA", then ErrorA is the last

error occured.

TEKEXP:LIST?

This command queries the list of available device, suite, test, version or

instrument.

Syntax

Outputs

TEKEXP:LIST? DEVICE\n

Returns the list of available device(s) as comma
separated values.

TEKEXP:LIST? SUITE\n

Returns the list of available suite(s) as comma
separated values.

TEKEXP:LIST? TEST\n

Returns the list of available test(s) as comma
separated values.

TEKEXP:LIST? VERSION\n

Returns the list of available version(s) as comma
separated values.

TEKEXP:LIST?
INSTRUMENT,"<InstrumentType>"\n

Returns the list of available instruments' for the
given Instrument type as comma separated
values.

Inputs  InstrumentType

TIP. Check Command parameters list for InstrumentType parameters.

Example  If TEKEXP:LIST? DEVICE\n returns "TX-Device,RX-Device" then TX-Device,

RX-Device are the available device.

If TEKEXP:LIST? INSTRUMENT,"Real Time Scope"\n returns Instrumentl,
Instrument2 then Instrumentl, Instrument2 are the list of available instruments.
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TEKEXP:MODE

Syntax

Inputs

Outputs

Example

TEKEXP:MODE?

Syntax

Inputs

Outputs

Example

This command sets the execution mode as compliance or user defined.

TEKEXP:MODE {COMPLIANCE | USER-DEFINED}\n

{COMPLIANCE | USER-DEFINED}

NA

TEKEXP:MODE COMPLIANCE\n to set the execution mode as compliance

This command queries the execution mode type.

TEKEXP:MODE?\n

NA

{COMPLIANCE | USER-DEFINED}

If TEKEXP:MODE?\n returns COMPLIANCE, then the execution mode is
compliance.
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TEKEXP:POPUP

Syntax

Inputs

Outputs

Example

TEKEXP:POPUP?

Syntax

Inputs

Outputs

Example

86

This command sets the response to the active popup shown in the application.

TEKEXP:POPUP “<PopupResponse>""\n

PopupResponse

NA

TEKEXP:POPUP “PopupResponseA’\n sets PopupResponseA as the response to

active popup in the application.

This command queries the active popup information shown in the application.

TEKEXP:POPUP?\n

NA

Returns the active popup information in the application.

If TEKEXP:POPUP?\n returns "PopupMessageA", then PopupMessageA is the
active popup information shown in the application.
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TEKEXP:REPORT

Syntax

Inputs

Outputs

Example

TEKEXP:REPORT?

Syntax

Inputs

Outputs

This command generates the report for the current session.

TEKEXP:REPORT GENERATE\n

GENERATE

NA

TEKEXP:REPORT GENERATE\n generates report for the current session.

This command queries the queried header field value in the report.

TEKEXP:REPORT? “<HeaderField>"\n

HeaderField - Specifies to return the measured value for the indicated test.

TIP. Check Report for HeaderField parameters.

Returns the queried header field value in the report
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Example

TEKEXP:RESULT?

Inputs

Example

88

If TEKEXP:REPORT? “Master Scope Information™\n returns "DPO73304SX",
then DPO73304SX is the scope model.

If TEKEXP:REPORT? “DUT ID”\n returns "DNI_DUTID", then DNI_DUTID
is the DUT ID.

This command queries the result available in report summary/details table.

Syntax Outputs

TEKEXP:RESULT? "<TestName>"\n Return Pass/Fail status of the test.
TEKEXP:RESULT? Returns all the row values of the specified
"<TestName>","<ColumnName>"\n column for the test.

TEKEXP:RESULT? Returns the column value for the specified row
"<TestName>","<ColumnName>",<RowNumber | number.

>\n

TestName - Specifies the name of the test for which to obtain the test result
value.

ColumnName - Specifies the column name for the measurement

RowNumber - Specifies the row number of the measurement

TIP. Check Report for TestName, ColumnName, and RowNumber parameters.

If TEKEXP:RESULT? "Period using SCOPE (Acquire-Analyze Combined)"\n
returns Pass, then the test result is Pass.

If TEKEXP:RESULT? "Period using SCOPE (Acquire-Analyze
Combined)","Margin",1\n returns "L:-50.000ps H:2000.000ps", then L:-50.000ps
H:2000.000ps is the value.

If TEKEXP:RESULT? "Measured Value","Clock Frequency",1\n returns
"2.9600413", then 2.9600413 is the value.
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TEKEXP:SELECT

This command selects the device, suite, version, or test.

Syntax ~ TEKEXP:SELECT <string1>,<string2>,<string4>\n
TEKEXP:SELECT TEST,<string3>,<string4>\n

Inputs  <stringl>= {DEVICE | SUITE | VERSION}
<string2> = {DeviceName | SuiteName | VersionName}
<string3> = {“<TestName>"| ALL| REQUIRED }
<string4>= {TRUE | FALSE}

TIP. Check Command parameters list for DeviceName, SuiteName, VersionName,
and TestName parameters.

Outputs NA

Example  TEKEXP:SELECT DEVICE, DeviceA, “TestNameA”\n selects DeviceA,
TestNameA.
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TEKEXP:SELECT?

Syntax

Inputs

Outputs

Example

TEKEXP:SETUP

Inputs

Example

90

This command queries the name of the selected device, suite, version, or test.

TEKEXP:SELECT? {DEVICE | SUITE | TEST | VERSION}\n

{DEVICE | SUITE | TEST | VERSION}

Returns the name of the selected device, suite, version, or test.

If TEKEXP:SELECT? DEVICE\n returns "TX-Device", then TX-Device is the

type of the selected device.

This command sets the value of the current setup.

Syntax Outputs
TEKEP:SETUP DEFAULT\n Restore to default Setup
TEKEP:SETUP OPEN,"<SessionName>"\n Open the session
TEKEXP:SETUP SAVE\n Save the session
TEKEXP:SETUP SAVE,"<SessionName>"\n Save the session

SessionName - The name of the session

TEKEP:SETUP DEFAULT\n restore to default setup.
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TEKEXP:STATE

Syntax

Inputs

Outputs

Example

TEKEXP:STATE?

Example

This command sets the execution state of the application.

TEKEXP:STATE {RUN | STOP | PAUSE | RESUME}\n

{RUN | STOP | PAUSE | RESUME}

NA

TEKEXP:STATE STOP\n sets the execution state of the application to stop.

This command queries the current setup state.

Syntax Outputs

TEKEXP:STATE? RUNNING | PAUSED | WAIT | ERROR | READY|
| STOPPED

TEKEXP:STATE? SETUP SAVED | NOT_SAVED

If TEKEXP:STATE?\n returns as READY, then the application is ready to run
next measurement.

If TEKEXP:STATE? SETUP\n returns as NOT _SAVED, then the current setup
is not saved.
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TEKEXP:VALUE

This command sets the value of parameters of type General, Acquire, Analyze, or
DUTID.

Syntax ~ TEKEXP:VALUE GENERAL,"<ParameterName>",“<Value>"\n

TEKEXP:VALUE ACQUIRE,"<AcquireType>", "<ParameterName>",
“<Value>"\n

TEKEXP:VALUE ANALYZE,"<ParameterName>".“<Value>"\n
TEKEXP:VALUE DUTID,“<Value>"\n

Inputs  ParameterName - Specifies the parameter name
AcquireType - Specifies the acquire type

Value - Specifes the value to set

TIP. Check Command parameters list for ParameterName, AcquireType, and
Value parameters.

Outputs NA

Example = TEKEXP:VALUE GENERAL,"Signal Type"\n sets the parameter name as
Signal Type for GENERAL.
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TEKEXP:VALUE?

Inputs

Outputs

Example

This command queries the value of the parameter for type General, Acquire,

Analyze, or DUTID.

ACQUIRE,"<AcquireType>","<ParameterName>
|l\n

Syntax Outputs

TEKEXP:VALUE? Returns the value of Parameter for type
GENERAL,"<ParameterName>"\n GENERAL

TEKEXP:VALUE? Returns the value of Parameter for type

ACQUIRE

TEKEXP:VALUE? Returns the value of Parameter for type
ANALYZE,"<ParameterName>"\n ANALYZE
TEKEXP:VALUE? DUTID\n Returns the DUTID value

ParameterName - Specifies the parameter name

AcquireType - Specifies the acquire type

TIP. Check Command parameters list for ParameterName and AcquireType

parameters.

Returns the value of Parameter for type GENERAL | ACQUIRE | ANALYZE |

DUTID.

If TEKEXP:VALUE? GENERAL,"Signal Type™\n returns "NINO", then N1NO
is the value of parameter Signal Type for GENERAL.
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Command parameters list

This section provides the parameters list for the SCPI commands.

Parameters Description

InstrumentType Specifies the instrument type.
Valid values are:
= AWG

= Real Time Scope

Value Specifies the value parameters.
= For InstrumentType, valid values are:
= Do notuse
m  MSO71254C ( GPIB8:1:INSTR)
= For DUTID, valid value is:

= Comment
DeviceName Specifies the device name. Valid value is Ethernet Tx
SuiteName Specifies the suite name.
Valid values are:
= 10GBASE-T
= 5GBASE-T
= 2.5GBASE-T
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Parameters Description
VersionName Specifies the version name. Valid value is Spec 1.0
TestName Specifies the test measurement name.

Valid values are:
= Maximum Output Droop

= Power Spectrum Density

= Tone-1
= Tone-2
= Tone-3
= Tone4
= Tone-5

= Clock Frequency

= Jitter Master

m  Jitter Slave

= Open Termination
m  Short Termination
= Load Termination

= Return Loss

ParameterName and Value for General, Acquire and Analyze

Specifies the ParameterName and Value for General, Acquire and Analyze. The
configuration parameters available are not same for measurements.

Table 14: ParameterName and Value for General

ParameterName Value
Report Update Mode . New

= Append

= Replace
Auto increment report name if | TRUE or FALSE
duplicate
Include Pass/Fail Results TRUE or FALSE
Summary
Include Detailed Results TRUE or FALSE
Include Plot Images TRUE or FALSE
Include Setup Configuration TRUE or FALSE
Include User Comments TRUE or FALSE
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ParameterName

Value

Save As Type

= Web Archive (*.mht;*.mhtml)
m  PDF (*.pdf)

View Report After Generating

TRUE or FALSE

Report Group Mode

= TestName
= Lane Name
= Test Result

= Equalization

Create report at the end

= Included

= Excluded
DUTID Comment User comment
Number of retries for instrument |0 to 5
10 errors
Run Test More than Once TRUE or FALSE
Number of Runs 1to 200
On Failure Rerun TRUE or FALSE
Number of Reruns On Failure 1to0 100
Time between retries (seconds) |5 to 60
Timer Warning Info Message . True"
Popup

= "FALSE"
Timer Warning Info Message 0to 20
Popup Duration
Timer Error Message Popup . True"

= "False"
Timer Error Message Popup 0to20
Duration
On Failure Stop and Notify TRUE or FALSE

Specification Details

= NBASE-T Phy Layer Spec 1.1
= |EEE P802.3bz, Section 126

Probing Type

SINGLE ENDED

Differential

96
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ParameterName Value

Link Widths o 1lane
= 2lanes
= 3lanes
= 4Llanes

Signal Validation

Prompt me if Signal Validation Fails
Skip Test if Signal Validation Fails

Use signal as is - Don't Validate

Lane A Connected to:Lane
A:Differential

Lane B Connected to:Lane
B:Differential

CH1
CH2
CH3
CH4

C:Differential

Lane C Connected to:Lane

D:Differential

Lane D Connected to:Lane

Single Ended

Lane A Connected to:Lane A+:

Single Ended

Lane A Connected to:Lane A-:

Single Ended

Lane B Connected to:Lane B+:

Single Ended

Lane B Connected to:Lane B-:

Table 15: ParameterName and Value for Acquire

Test Name

AcquireType

ParameterName

Value

Maximum Output
Droop

Maximum Output
Droop-Acquisition

Population

100 to 5000 (units - clock cycles)

Power Spectrum Power Spectrum AcquisitionAverage 2 to 256
Density Density-Acquisition

Tone-1 Tone-1-Acquisition | AcquisitionAverage 210100
Tone-2 Tone-2-Acquisition | AcquisitionAverage 2t0 100
Tone-3 Tone-3-Acquisition | AcquisitionAverage 210100
Tone-4 Tone-4-Acquisition | AcquisitionAverage 2t0 100
Tone-5 Tone-5-Acquisition | AcquisitionAverage 210100

Clock Frequency

Clock Frequency-
Acquisition

Population

10000 to 2000000 (clock cycles) for data rate
-10G

100 to 2000000 (clock cycles) for data rate -
5G and 2.5G
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Test Name AcquireType ParameterName Value

Jitter Master Jitter Master- AcquisitionDuration 0.1 msto 10 ms
Acquisition

Jitter Slave Jitter Slave- AcquisitionDuration 011010
Acquisition

Open Termination Open Termination- | AcquisitionAverage 2t0128
Acquisition

Short Termination Short Termination- | AcquisitionAverage 2t0128
Acquisition

Load Termination Load Termination- | AcquisitionAverage 210128
Acquisition

Return Loss Return Loss- AcquisitionAverage 0to102t01280to 10
Acquisition

Table 16: ParameterName and Value for Analyze

Test Name ParameterName Value
Maximum Output Droop | RefLevel = Percentage
= Absolute
MidLevel If Ref Level is Percentage then 20 to 80
If Ref Level is Absolute then -10 mV to 10 mV
Hysteresis If Ref Level is Percentage then 2 to 20
If Ref Level is Absolute then -2 to 2
StartTime 5nsto15ns
EndTime = For 10GBASE-T, 85 ns to 95 ns
m  For 5GBASE-T, 160 ns to 180 ns
m  For 2.5GBASE-T, 320 ns to 340 ns
Power Spectrum Density | StartFrequency 1 MHz to 1500 MHz
StopFrequency 1600 MHz to 4000 MHz
ResolutionBandwidth 1 MHz to 5 MHz
PowerLevelStartFrequency 1 MHz to 1500 MHz
PowerlevelStopFrequency 1600 MHz to 4000 MHz
Smoothing Average 110100
Tone-1 StartFrequency 1 kHz to 30000 kHz
StopFrequency 350000 kHz to 800000 kHz
ResolutionBandwidth 20 kHz to 500 kHz
Tone-2 StartFrequency 1 kHz to 30000 kHz
StopFrequency 350000 kHz to 800000 kHz
ResolutionBandwidth 20 kHz to 500 kHz
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Test Name ParameterName Value
Tone-3 StartFrequency 1 kHz to 30000 kHz
StopFrequency 350000 kHz to 800000 kHz
ResolutionBandwidth 20 kHz to 500 kHz
Tone-4 StartFrequency 1 kHz to 30000 kHz
StopFrequency 350000 kHz to 800000 kHz
ResolutionBandwidth 20 kHz to 500 kHz
Tone-5 StartFrequency 1 kHz to 30000 kHz
StopFrequency 350000 kHz to 800000 kHz
ResolutionBandwidth 20 kHz to 500 kHz
Clock Frequency RefLevel = Percentage
= Absolute
MidLevel If Ref Level is Percentage then 20 to 80
If Ref Level is Absolute then -10 mV to 10 mV
Hysteresis If Ref Level is Percentage then 2 to 20
If Ref Level is Absolute then 0 mV to 4 mV
Jitter Master RefLevel = Percentage
= Absolute
MidLevel If Ref Level is Percentage then 20 to 80
If Ref Level is Absolute then -10 mV to 10 mV
Hysteresis If Ref Level is Percentage then 2 to 20
If Ref Level is Absolute then 0 mV to 4 mV
Jitter Slave RefLevel = Percentage
= Absolute
MidLevel If Ref Level is Percentage then 20 to 80
If Ref Level is Absolute then -10 mV to 10 mV
Hysteresis If Ref Level is Percentage then 20 to 80

If Ref Level is Absolute then 0 mV to 4 mV

Open Termination

SmoothingAverage

11010

Short Termination SmoothingAverage 11010
Load Termination SmoothingAverage 11010
Return Loss SmoothingAverage 11010
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Acquisition tab, 24 File name extensions, 9
Analysis options, 30
Application panels overview, 12 G

Application version (show), 7

B

Button H
clear log, 31

GPIB, 17

Help conventions, 2
Email settings, 30 peony

save, 31 I

C Installing the software
TekExpress Ethernet Tx Solution, 7
Instrument-DUT setup, 39

Instruments
discovering connected, 17

Compensate the signal path, 48
Configuration tab, 20

Configuration tab parameter
instruments detected, 26

Configuration tab parameters
global settings, 26

Connected instruments

viewing connected, 17
Instruments detected, 26

searching for, 17 K
Connection requirements, 39
Create a test setup from default settings, 52 Keep on top, 11

Create a test setup using an existing one, 52

D

L

LAN, 17
DUT ID, 22 License agreement (show), 7
DUT parameter Live waveforms, 22

device, 22 Loading a test setup, 52

device profile, 22

Log view
optical module settings, 22 save file, 31
optical power, 22
DUT type M
device, 22
DUT-instrument setup, 39 Maximum output droop, 53
Menus
E Options, 15

Email notification and setup, 19 Minimum system requirements, 5
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Non-VISA, 17
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Opening a saved test setup, 52

Options menu
Instrument control settings, 17

keep on top, 11
Oscilloscope compensation, 48

P

Panels, 12

Pattern, 22

Pattern type, 22
Preferences menu, 32

Preferences tab
send an Email, 30

setup panel, 30

R

Recalling a test setup, 52
Recommended probes, 6
Related documentation, 1
Report contents, 37
Report name, 35

Report options, 35
Report sections, 37

Reports
receiving in email notifications, 19
Reports panel, 12, 34

Resource file, 11

Results panel
summary of test results, 32

test name, 32
Running tests, 50

S

Save log file, 31
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Schematic button (DUT-instrument setup), 39

SCPI commands
Command parameters list, 94

TEKEXP:*IDN?, 79
TEKEXP:*OPC?, 79
TEKEXP:ACQUIRE MODE, 80
TEKEXP:ACQUIRE MODE?, 80
TEKEXP:EXPORT, 81
TEKEXP:INFO?, 81
TEKEXP:INSTRUMENT, 83
TEKEXP:INSTRUMENT?, 82
TEKEXP:LASTERROR?, 83
TEKEXP:LIST?, 84
TEKEXP:MODE, 85
TEKEXP:MODE?, 85
TEKEXP:POPUP, 86
TEKEXP:POPUP?, 86
TEKEXP:REPORT, 87
TEKEXP:REPORT?, 87
TEKEXP:RESULT?, 88
TEKEXP:SELECT, 89
TEKEXP:SELECT?, 90
TEKEXP:SETUP, 90
TEKEXP:STATE, 91
TEKEXP:STATE?, 91
TEKEXP:VALUE, 92

TEKEXP:VALUE?, 93
Search for connected instruments, 17
Selecting test report contents, 35
Selecting tests, 23
Serial, 17
Session folders and files, 33
Setting up equipment, 39
Setup
acquisition tab, 24
Setup files, 51

Setup panel
DUT parameter, 20

preferences tab, 20

test selection, 20
Signal conditioning
bandwidth, 22

filter, 22
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TekExpress Ethernet Tx Solution, 7
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Status panel
log view, 31
message history, 31

test status tab, 31
System requirements, 5

T

Technical support, 2
Tek Link, 17
Test reports, 37

Test results

send by email, 19
Test selection

Clock Frequency, 23

Jitter Master, 23

Jitter Slave, 23

Linearity, 23

Maximum Output Droop, 23
Power Spectrum Density, 23

Return Loss, 23
Test selection controls, 23

Test setup files, 33, 51

Test setups
load, 52

open, 52
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acquire status, 31

analysis status, 31

auto scroll, 31
Test-related files, 33

Tests
running, 50
selecting, 23

U

USB, 17

User Comments
including in reports, 36

vV

View a report, 37

View application license agreement, 7
View application software version, 7
VXI, 17

W

Waveform files
locating and storing, 33
Wavelength, 22
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